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1 0BIntroduction 
The SX1230 is a single chip transmitter IC designed for operation in the licence free ISM bands between 290 and 
1020 MHz. The SX1230 is capable of operation either with or without an external companion microcontroller and 
features four internally de-bounced digital input pins to enable direct connection to switchgear for wireless remote 
control applications. Examples of both types of applications are shown below: 
 

 

Figure 1. SX1230 Stand Alone Operation with Companion E
2
PROM 

 

Figure 2. SX1230 Connections for Microcontroller Based Operation 

The SX1230 main features include:  
 +17 dBm to -18 dBm Programmable output power 
 1.8 to 3.7V Operating range with internal voltage regulation allowing constant RF performance 
 Narrow and wide-band operation 
 (G)FSK, (G)MSK and both filtered and unfiltered OOK operation. 
 Support of bit rates from 1.2 to 600 kbps. 
 Low battery detection 
 Integrated RC timer for timer / wake-up applications 
 Low phase noise -95 dBc/Hz at 50 kHz offset. 
 -40°C to +85°C Temperature Range 
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2 1BGetting Started 

2.1 10BKit Contents 
As illustrated in the figure below, the SX1230-12SKA Evaluation kit is composed of: 

 SX1230SKA board 
 SX1212SKA board 
 SMA Connectorised Antenna for 434 MHz 
 SX1230-12SKA CDROM including all necessary PC software and documentation 
 A CR2032 Cell for operation of the SX1230SKA in stand alone mode, in conjunction with the companion 

E
2
PROM. 

 

Figure 3: SX1230-12SKA Contents (CR2032 Cell not Shown) 

 

2.2 11BInstallation 
The software for the SX1212SKA and SX1230SKA must each be installed individually. The installation process for 
each is identical.  
 
SX1212SKA Advanced Mode Software Installation 

1- Put the CDROM in your computer and browse the contents of the CD. 
2- Open the “sx1212starterkitsetupweb.exe” manually. It can be found in the \Installers sub directory of the 

CD-ROM. 
3- Follow installation guidelines until the process is completed. Please note that .NET Framework 2.0 and the 

FTDI USB driver will be automatically installed if not detected on your computer. 
4- Connect the SX1212SKA board to the PC via the USB interface. 
5- Launch “SX1212SKA” from the Start menu. 
6- Click on “Connect” button in toolbar or in File menu. 
7- SX1212SKA is now installed and ready to be used. 

 
SX1230SKA Advanced Mode Software Installation 

8- Put the CDROM in your computer and browse the contents of the CD. 
9- Open the “sx1230starterkitsetupweb.exe” manually. It can be found in the \Installers sub directory of the 

CD-ROM. 
10- Follow installation guidelines until the process is completed. Please note that .NET Framework 2.0 and the 

FTDI USB driver will be automatically installed if not detected on your computer. 
11- Connect the SX1230SKA board to the PC via the USB interface. 
12- Launch “SX1230SKA” from the Start menu. 
13- Click on “Connect” button in toolbar or in File menu. 
14- SX1230SKA is now installed and ready to be used. 
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3 2BHardware Description 
SX1230SKA and SX1212SKA boards are summarised in this chapter. Please refer to the schematics and layout 
provided in the document for further information about each hardware implementation. 

3.1 12BSX1230SKA Overview 

 

Figure 4: SX1230SKA, 868 and 915 MHz Band, Board Picture 

 
The SX1230SKA is a USB based evaluation tool, which sees the SX1230 reference design (2) connected to a host 
PC via an FTDI USB to SPI bridge (1) and USB type ‘A’ connection (7). The SX1230SKA can also operate with in 
stand alone mode when battery powered. In this mode the initial configuration of the radio is downloaded from the 
first 77 bytes of the companion E

2
PROM (5). In response to a user push button input (6) a specific payload may be 

transmitted. The LED (3) corresponding to that button press illuminates to indicate transmission. 
 
For operation in the 434 MHz band the RF link between SX1230SKA and SX1212SKA is established through a PCB 
mounted helical antenna (4) to give a realistic impression of the range and other performances attainable in a 
miniaturised application.  

4 

3 
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3.2 13BSX1212SKA Overview 
The SX1212SKA features the SX1212 reference design (1) and is also interfaced via an FTDI bridge (6) to the USB 
type ‘A’ interface (2) of a host PC. Unlike the SX1230SKA, it has no provision for operation disconnected form the 
USB port. Indication of transmission and reception is indicated on a pair of LEDs (4). Connection to the separate 
antenna is made through an SMA connector (3) which can also be useful for laboratory based testing. 
 

 

Figure 5: SX1212SKA Board Picture 
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4 3BQuick Start Guide: MCU Mode 
With both SX1230SKA and SX1212SKA software installed, follow the sequence below to establish communication 
between the SX1230 as transmitter and the SX1212 as receiver. 

 

4.1 14BSX1212SKA Quick Start 
1. Plug the SX1212SKA into the USB port of the computer. 

 

2. Run the SX1212 User Interface software Start > All Programs > SX1212SKA > SX1212SKA 

 

3. The SX1212SKA should connect automatically to the User Interface 
Software. If not, then click on the USB connect short-cut button, located in 
the top left hand corner of the window. 

 

4. Once connected the SX1212SKA shows the default configuration of the SX1212 register settings 
upon power-up. 

 

Figure 6. SX1212 User Interface, Default Settings 

 
5. Once connected the SX1212SKA shows the default configuration of the SX1212 register settings 

upon power-up (as shown in XFigure 6X). 

 



 
ADVANCED COMMUNICATIONS & SENSING    

 

Revision 1 March 2009 © 2009 Semtech Corp.  www.semtech.com 
 9  
 

User’s Guide
SX1230-12SKA

6. The settings for communication between SX1212SKA and SX1230 SKA are 
located on the installation CD-ROM provided with the kit. Use the File > Open 
from the menu bar, or the open short-cut button to load a configuration file. 

 

7. Load the “434_SX1212_pingpong.cfg” file from the “SX1212 Demo Files” folder on the CD-ROM.  

 

8. The display will then appear as shown in XFigure 7X. These are the link parameters which match 
those which will be programmed to the SX1230SKA. 

 

Figure 7. The New SX1212 Configuration: Ready to be Written 

 

9. By clicking on the write button in the ‘Registers config’ section, the 
new register values are written to the SX1212 registers. If 
successful, the red values in the hexadecimal register summary 
table will turn black. As a double check, the register read button 
may be pressed – the values presented on the user interface 
should remain unchanged. 

 

10. Click on the ‘Packet’ tab to access the packet testing portion of the program. Within this window a 
pre-defined packet structure is already configured. It remains simply to click the ‘Reception’ radio 
button and press the Start button. At this point the SX1212SKA enters packet receive mode and is 
now listening for valid packets. At this juncture the SX1230SKA transmitter must be configured. 
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Figure 8. The SX1212SKA User Interface whilst in Packet Receiver Mode 

 

4.2 15BSX1230SKA Quick Start 
 

1. Plug the SX1230SKA into the USB port of the computer. 

 

2. Run the SX1230 User Interface software Start > All Programs > SX1230SKA > SX1230SKA 

 

3. The SX1230SKA should connect automatically to the User Interface 
Software. If not, then click on the USB connect short-cut button, located in 
the top left hand corner of the window. 

 

4. Once connected the SX1230SKA shows the default configuration of the SX1230 register settings 
upon power-up (see XFigure 9 X). 
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Figure 9. SX1230 User Interface, Default Settings 

 

5. The settings for communication between SX1212SKA and SX1230SKA are 
located on the installation CD-ROM provided with the kit. Use the File > 
Open from the menu bar, or the open short-cut button to load a configuration 
file. 

 

6. Load the “434_SX1230_pingpong.cfg” file from the “SX1230 Demo Files” folder on the CD-ROM. 

 

7. The display will then appear as shown in XFigure 10 X. These are the link parameters which match 
those which will be programmed to the SX1212SKA. 
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Figure 10. The New SX1230 Configuration: Ready to be Written 

 

 

 

8. By clicking on the write button in the ‘Registers config’ section, the 
new register values are written to the SX1230 registers. If 
successful, the red values in the hexadecimal register summary table 
will turn black. As a double check, the register read button may be 
pressed – the values presented on the user interface should remain 
unchanged. 

 

 

 

9. Once successfully configured, the SX1230 must be placed in packet transmission mode. This is 
done by selecting the ‘MCU mode’ tab – note that a pre-configured frame format identical to that for 
the SX1212SKA is already entered into the display. It suffices simply to click on the ‘Start’ button to 
begin continuous transmission of this frame. For clarity a screenshot illustrating the display during 
transmission is shown in XFigure 11X. 
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Figure 11. SX1230 During MCU Mode Packet Transmission 

 

4.3 16BLink Test 
With both devices configured as described in the preceding two sections, reception of valid packets by the SX1212 
should be visible. Note that during link testing be sure that the USB kits are separated by several cm. Note also, that 
it is possible to install the SX1212SKA user interface on one machine and the SX1230SKA user interface on 
another allowing range test evaluation with full control over the link parameters. 

Where a pair of computers is not available, the SX1230SKA can be configured in stand alone mode. Please see the 
next section for a quick start guide on operation of the SX1230SKA in this mode. 
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5 4BQuick Start Guide: Stand Alone Mode 
 

5.1 17BSX1212SKA Configuration 
Initiation of the SX1212SKA for operation in Stand Alone Mode is identical to that described in Section X4.1 X. Please 
configure the SX1212SKA as described therein and refer to the following section for configuration of the SX1230. 
 

5.2 18BSX1230SKA Configuration 
There are a few simple steps to follow to configure the SX1230SKA for stand alone mode operation. XFigure 12 X 
shows both top and bottom views of the SX1230SKA hardware. The SX1230SKA companion EEPROM comes pre-
programmed with a band specific configuration file already loaded. 
 

1. Insert the CR2032 button cell into the cell holder (1), taking care to respect the polarity. Note that there is 
some quiescent current drain caused by the USB interface, so to maximise battery life ensure this is 
removed when not in use. 

 
2. Three of the four push buttons (labeled 0 to 3 on the PCB silkscreen) are connected to the general 
purpose digital inputs of the SX1230. The button labeled 3 is configured as a reset button. Push this button 
following connection of the cell. There should now be no LEDs illuminated on the SX1230SKA. 

 

 

 

Figure 12. Hardware for E
2
PROM (Stand Alone) Operation 

 
3. The SX1230SKA is not ready to be used in conjunction with the SX1212SKA in frame reception mode, as 
described in Section X4.1 X. 
 

2 

2 1 

3 
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5.3 19BLink Test 
Each push button has the same payload mapped to it. Push button 0 transmits this single, standard format frame, 
once. Push button 1 has a demonstration of packet repetition. Here the packet is programmed to be resent five 
times. Note that the SX1212SKA may not receive all five frames successfully. This is due to the time required to 
empty the FIFO, whereas SX1230 will transmit all five frames in quick succession. Finally, push button 2 gives a 
demonstration of periodic mode. Here the frame is configured to repeat several times a second whilst the push 
button is held down. 
 
To modify the E

2
PROM contents please see Section X6.7 X. Note also that the original quick start configuration is 

included on the CD. Please also refer to Section X6.7 X on how to load a non-volatile memory configuration file and 
program the E

2
PROM. 

 
Otherwise, guidance for performing link testing is the same as that already given in Section X4.3 X. 
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6 5BSX1230SKA Software Description 

6.1 20BOverview 
XFigure 13X shows the SX1230SKA graphical user interface (GUI). Each of the numbers surrounding the display 
corresponds to the Chapter within this section gives the description of that feature. 
 

 
 

 Figure 13: SX1230SKA GUI Overview and References to the User Guide Description of this Chapter. 
 

6.2 21BFile Menu 
File menu contains some general purpose functions. The first feature in the list provides 
the possibility of connecting or disconnecting to the USB kit. Care must be taken to ensure 
that the USB port is closed before unplugging the USB kit. This functionality may also be 
accessed through the short cut buttons (see Section X6.3 X). 
 
The possibility of opening configuration files and saving the present configuration is also 
provided. This is done through a standard Windows file dialog box. 
 
 

The Help menu contains two menu items. The first item provides a link 
to this user guide in PDF format. The second, ‘About SX1230 Starter 
kit…’, gives information in the revision of the software installed. 
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6.3 22BShortcut Buttons 
The shortcut buttons provide identical functionality to those listed under the file menu 

  

The configuration ‘file open’ shortcut button. This opens a windows file dialog box to allow access 
to previously saved SX1230 register configuration files. 

 

 The ‘save’ configuration file shortcut button immediately saves and overwrites the existing 
configuration file. 

 

The ‘connect / disconnect’ button allows the user to manage manually connection and 
disconnection of the kit. Note that any time the SX1230SKA is to be removed from the system; the 
kit must first be disconnected. 

 

The saved configuration files are designed to be a useful tool for embedded software development. The file can be 
opened in any text editor to display the programmed register name, address and hexadecimal value programmed to 
that address. 

 

Figure 14. Example Text Editor Output of the SX1230 Configuration File 
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6.4 23BGeneral Configuration Tabs 
For clarity and ease of use the general configuration settings have been split between two tabs. 

6.4.1 42BGeneral [1] 
The most commonly used configuration parameters are located on the General [1] tab. Each field is directly editable 
by the user and is refreshed every time a register read or write is performed.  
 

 

Figure 15. The General Configuration Tab Features the most Commonly Used Configuration Parameters 

 
Where the data entry field allows direct keyboard entry, the following background highlight conventions are used to 
aid the user in their choice of programmed value: 
 

An orange background highlight indicates that the precise 
value entered into the data entry field is not directly 
addressable by the SX1230. Instead the closest 
(rounded) value will be used. 

 
Conversely a red background highlight indicates where 
the maximum or minimum value for that register 
parameter has been exceeded.  
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Each data entry field and user control of the General [1] tab is described below. 
 
RF Frequency 

The RF frequency field accepts a numerical text input 
from the keyboard. Values in any one of the three 
frequency bands from 290 to 1020 MHz are permitted. 
Please note that the entry units are Hz. 

 
Modulation Type 

The SX1230 is capable of both FSK and OOK modulation, 
they are selectable through the user interface by clicking 
with the mouse on the appropriate radio button.  

 
 
Modulation Shaping 

The Tx bit-stream may be pre-filtered before modulation. 
Varying strengths of filtering are accessible. The filter type 
also depends upon the type of modulation used. Filter 
coefficients are selectable from a drop-down menu. 

 
Bitrate 

 The bit rate of the transmitted signal (in bps) can be 
directly edited in this data entry field.  
 

 
 
Frequency Deviation 

Text entry field for the frequency deviation when using 
FSK modulation. 
 

 
 
Power Amplifier 

Selection of single (low power) or dual (high power) 
operation. Note that PAs 1 and 2 must be enabled for 
+17 dBm operation. 

 
 
Output Power 

The output power is selectable from a drop down list in 
the programmable 1 dB increments. 
 

 
PA Ramping 

The PA ramp rise time is selectable from the list of 
programmable values. 
 

 
Oscillator 

Although not directly accessible from the SX1230SKA, 
for completeness, the source of the clock output signal 
can be selected and its frequency altered in accordance 
with the range of programmable divider values. For 
more information please consult the SX1230 datasheet. 
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Push Button Debouncer 
The four general purpose digital inputs – here connected 
to the four push buttons – has a variable debounce 
timer. Several common values are accessible from a 
drop down menu. 

 
 
PLL Lock Detection Parameters 

Three LED type indicators display the status of the 
SX1230 following the last register read cycle of the 
SX1230. Various options exist for changing the PLL 
divider ratio and triggering PLL calibration. Please 
consult the SX1230 datasheet for a more detailed 
description. 
 
 
 
 
 

 
 
E

2
PROM Mode Parameters 

These two register settings are used to determine the 
size of each section in the E

2
PROM memory and the 

wake-up time if periodic mode is enabled respectively. 
Please see Section X6.7 X, in conjunction with the SX1230 
datasheet, for a description of how to use these 
E

2
PROM parameters. 

 
 
Low Battery Detection Parameters 

The battery end of life (EOL) indicator is set if the EOL is 
enabled (here controlled by a radio button input) and the 
supply voltage passes the corresponding threshold – 
EOL trim. 
 
 
 

 
Crystal Frequency 

Most of the programmable communication setting 
parameters are a function of the crystal frequency used. 
This field allows other crystal frequencies to be tried, 
however, the SX1230SKA comes fitted with a 32 MHz 
crystal. The value should hence not be changed. 
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6.4.2 43BGeneral [2] 

 

Figure 16. Second Page of the General Configuration Parameters 

The second page of general configuration settings (see XFigure 16X) contains the user inputs for enabling of the power 
amplifier over current protection (OCP) and setting the current limit from a drop down menu. The current limit must 
be increased to 100 mA or higher for operation of the SX1230 at the maximum output power of +17 dBm. 

 

6.5 24BRegister Hexadecimal Display 
XFigure 17X shows the register summary of the SX1230. In addition to manual user entry in the fields described in the 
previous section, direct hexadecimal entries may be made into the register display. Note that values yet to be written 
to the SX1230 registers appear in red. Note, also, that for full control flexibility, incorrect (red) values entered in the 
hexadecimal section will still be written in the event of a register ‘write’. So care must be exercised when editing the 
hexadecimal values. 
 

 

Figure 17. Register Hexadecimal Display 

 

Note that values changed in this portion of the display cause the values in the tabbed configuration section to be 
changed dynamically.  
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6.6 25BOverview Panel 
A summary of the values presently entered into the user interface software is shown in the overview display at the 
bottom of the screen. This covers all of the SX1230 register values, including those not displayed on the tab 
presently selected, and indicates the true value which will be written to the SX1230 configuration registers. 
 

 

Figure 18. The Configuration Overview Display 

 

6.7 26BE2PROM Mode Tab 
The E

2
PROM mode tab is used to configure the contents of the E

2
PROM for stand alone mode operation of the 

SX1230SKA. In this mode the SX1230 acts as SPI master and can download both configuration and payload 
information from an SPI E

2
PROM. The E

2
PROM memory map is shown below: 

 

 

Figure 19. E
2
PROM Memory Mapping 

 
The bottom 0x4C locations in the E

2
PROM are reserved general configuration information – configuration which is 

the same for every button press. The subsequent sections are then mapped to the remaining 15 possible 
combinations of the 4 digital inputs (for mapping details please see the SX1230 datasheet). These may contain 
either i) solely payload or ii) a combination of supplementary configuration information and payload. 
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Figure 20. The E
2
PROM Mode Tab ‘Normal View’ 

 
The E

2
PROM mode display is broken down into two types, selectable by the radio button control in the bottom right 

hand corner of the display. The default is ‘Normal view’ which shows the E
2
PROM contents in human readable 

format (see XFigure 20X). The left hand ‘General Configuration Section’ dictates which registers are to be written to the 
general configuration section – True indicating that the value will be written, False that it will not. The values written 
to the configuration section are taken from the General setting tabs of Sections X6.4.1 Xand X6.4.2 X. The general 
configuration settings may be read or written independently of the rest of the E

2
PROM contents by clicking the Read 

or Write button within the section. 
 
The rightmost frame contains the contents of each of the input specific sections. The contents of a particular section 
are displayed individually. The section may be changed by entering the desired section in the ‘Section #:’ input. 
Several useful common parameters and the payload itself are listed within the ‘Buttons’ section. Each can be edited 
directly. The input specific section of the E

2
PROM memory can be written or read independently of the rest of the 

E
2
PROM contents by clicking on the write or read button within the Buttons Section. 

 
At the bottom of the display are the controls for global read or write of the E

2
PROM contents. These cause the 

whole E
2
PROM to be read or written, respectively.  

 
The radio button control in the bottom right hand corner allows selection between Normal and Raw views of the 
E

2
PROM contents. 

 
An alternative perspective of the E

2
PROM contents is available in ‘Raw view’, illustrated in XFigure 21X. Here we see 

the E
2
PROM contents in hexadecimal (centre column) and ASCII (right column) versus the E

2
PROM address in 

hexadecimal (left column) in tabular format. Note also the addition of several short-cut buttons. These allow the user 
to save or recall E

2
PROM (.NVM – non volatile memory) files to or from disc storage. Copy, cut and paste 

functionality is also provided. 
 
Once programmed the SX1230 may be disconnected from the USB port, unplugged and used in stand-alone mode. 
The SX1230SKA comes pre-programmed with an example E

2
PROM contents (see the quick start Section for more 

details). 
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Figure 21. E
2
PROM Raw View 

 

 

Figure 22. E
2
PROM Raw View Short-cut Buttons 
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6.8 27BMCU Mode Tab 

 

Figure 23. MCU Mode Tab Display 

 
The MCU mode tab allows the user to define a custom packet for transmission by the SX1230SKA. The packet 
configuration section (top) allows the user enable and set the length of a pulse train preamble (sent at the data rate). 
A custom syncronisation word of up to 4 bytes may also be added. Fixed or variable length packets may also be 
stipulated (see the SX1212 datasheet for more information), as may an optional 1 byte address. 
 
With these options entered the constructed packet is shown in the ‘Packet’ frame. The packet payload may also be 
edited in either ASCII or hexadecimal. Packet transmission starts when the ‘Start’ button is pressed. Either infinite 
transmission (repeat value = 0) or a finite number of packets may be transmitted by editing the repeat value. 
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